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1 Welcome to Contour

CONTOUR USER GUIDE
Getting Started and Learning the Essentials of Contour.

Updated for version 2.5 

OVERVIEW

Welcome to Contour.

Jama Contour is designed to provide you and your entire team a centralized, light-weight
application for managing the development of new technology products.  This user guide is written
to help you get started and orient you to the capabilities, terminology and way in which Contour
works.  

We try to make things as intuitive and straight-forward as possible, but Contour is a powerful and
flexible application and product management is a complex discipline, so we know this guide won’t
provide all the answers.  An experienced project manager would refer to this as “setting realistic
expectations with the customer”.  So, if you don’t see an answer to a question you have in this
guide or need clarification, please contact us at support@jamasoftware.com and we’ll be happy to
help.

We invite you to join us and other customers in the Jama Backstage to get free online support,
access other resources and participate in discussions around Contour best practices.  

Thanks for choosing Contour.

www.jamasoftware.com 

2 Installing Contour

These instructions are for new installations only.  If you have an existing version of Contour, you’ll
want to follow the upgrade guides on http://www.jamabackstage.com in documentation.

2.1 Installation Overview

To install Contour you’ll need to complete one of the following installation options which can take
15-45 minutes depending on what pre-requisite software you'll need to download.

Evaluation Installation (15-30 Minutes)

mailto:support@jamasoftware.com
http://www.jamabackstage.com
http://www.jamasoftware.com
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This is a quick installation that uses an embedded database and application server downloaded
with Contour for evaluation purposes.

1. Review System Requirements

2. Install Java JDK 5.0 / 1.5 (If not already installed) 

3. Download and unzip Contour

4. Open your browser and configure Contour by following the on-screen web-based prompts

Production Installation (30-45 Minutes)

This installation utilizes separate database server, application server and Contour downloaded
without the application server.

1. Review System Requirements

2. Install Java JDK 5.0 / 1.5 (If not already installed) 

3. Install a database and create a Contour schema

4. Install Apache Tomcat Application Server

5. Download and unzip Contour

6. Open your browser and configure Contour by following the on-screen web-based prompts

2.2 System Requirements

Server Requirements
To install and run Contour, you’ll need administrative rights to the computer along with the
following:

· Hardware

o Recent CPU, 1.5GHz or higher

o 1GB RAM minimum, 2-3GB recommended

o 100MB disk space for Contour files, additional space for file attachments

· Operating System

o Windows 2000, XP, 2003 Server, Vista

o MAC OS X

o Linux or UNIX

· Software

o Java JDK

o Application Server (We support and include Apache Tomcat)

o A database (We include HSQL in the download).  We support MySQL, Microsoft SQL
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Server 2000 and 2005.  We can offer custom support for  other databases, please check
with us for support of your favorite database.

Contour Client Requirements
Contour runs within a standard web browser.  Supported browsers include:

· Microsoft Internet Explorer 7.0  (We do offer backward support to 6.1 though performance
will be impacted)

· Mozilla Firefox 3.x

· Apple Safari

You’ll need a high speed internet connection and a PC with at least 1GB of RAM.  We have some
specific recommendations to tune your web browser available here.

2.3 Install Java

Contour is a J2EE application and requires the Java Development Kit (JDK) 1.5 or higher.  You may
already have Java installed – if so, you may skip this; otherwise follow these steps to install Java.

Download and install the Java Runtime Environment 5.0 (Currently update 17 as of Jan 09).  Note –
Sun’s download page changes often so these steps may differ from what you see.

· Download from: http://java.sun.com/javase/downloads/index_jdk5.jsp

· Look for the section "JDK 5.0 Update 17" (about the middle of the list), Click on "Download" 

· Accept the license by clicking in the radio button

· Choose correct version for your platform – Java Runtime Environment 5.0 Update 14

For example, if you are running Windows select:

Windows Offline Installation, Multi-language  jre-1_5_0_14-windows-i586-p.exe

· Install Java on your system

Set Java_HOME SYSTEM VARIABLE

Next, you’ll need to create an environment variable that tells Apache Tomcat, the server that is
included with Contour, where Java is installed.  Unfortunately, Apache can’t find Java on its own.

Windows Environments

1. Open your System Properties, Press Windows key + Pause/Break Key together OR click
Start à Control Panel à System

2. Click on “Environment Variables”

3. In the System Variables section, click “New”

4. Enter “JAVA_HOME” as the Variable name

5. Enter the path (pasting it in is easier) to the root of your java install folder – typically found
at C:\Program Files\Java\{version Name}

http://java.sun.com/javase/downloads/index_jdk5.jsp
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6. Click “OK”, “OK”, Close system properties

Linux & UNIX & MAC Environments

Set the JAVA_HOME Environment variable to the path of your Java installation

1. Edit the ".profile" file in your home folder (or corresponding file for your shell).

2. Set the JAVA_HOME environment variable by adding the following line to the file:
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3. export JAVA_HOME=/path/to/java/folder

4. Be sure there are no spaces after the end of the folder name.

5. Do not add an extra slash after the folder name.

6. Save changes to the file and then "source" it: source .profile

2.4 Install Database

Production Installations

For production installations, you’ll want to install a supported a database such as MySQL and
create a schema for Contour.  Jama supports:

· MySQL 5

· Microsoft SQL Server 2000, 2005 

· HSQL (Included embedded database)

· Oracle 10g

Contour uses Hibernate which enables support for most all common database platforms.  If you
are interested in finding out about custom support for other databases, please contact support.

MySQL Installation

MySQL is Jama's recommended database server for Contour.

1. Download and install MySQL 5.0 for your operating system http://dev.mysql.com/
downloads/mysql/5.1.html

2. Create an empty Contour schema / database.  This can be done either from the MySQL
command line client or from the downloadable MySQL Administrator.   From the
command line client after logging in, enter the following statement:

create database contour character set utf8;

3. Create a user with read/write access to Contour

Microsoft SQL Server

1. Install Microsoft SQL Server

2. Create a new database called “Contour”

3. Create a user with read/write access to Contour

Oracle 10g

1. Install Oracle Server

2. Create a user/schema called "Contour" with read/write access

http://dev.mysql.com/downloads/mysql/5.1.html
http://dev.mysql.com/downloads/mysql/5.1.html
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2.5 Install Application Server - Apache Tomcat

Install Apache Tomcat

Download and Install from http://tomcat.apache.org/download-55.cgi

Ensure that Tomcat is running properly by opening a browser to: http://localhost:8080 and
confirm you see the Tomcat welcome page.

Configure Apache Tomcat for Contour

Configure Tomcat Memory Settings

Windows Environments

If running Tomcat as a service, Open up the Tomcat Monitor (TOMCAT_HOME/bin/tomcat5w.

exe)

 Navigate to Configure   Java   Java Options and append:

-Xmx1024M
-XX:MaxPermSize=128M

Note: Make sure there are no spaces after each line, otherwise Tomcat will not start.

Linux / Unix / Mac Environments

· Set up environment variable CATALINA_OPTS=-Xmx1024M –XX:
MaxPermSize=128M 

· Add the following line to .bashrc file in the home folder of the user who runs Tomcat:

http://tomcat.apache.org/download-55.cgi
http://localhost:8080
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· export CATALINA_OPTS=”-Xmx1024M –XX:MaxPermSize=128M” 
· Run % source .bashrc
· Restart Tomcat 

2.6 Install Contour

Download & Unzip Contour

Download and unzip the distribution file, contour_rel_x.zip into a temporary location.  Please
contact support or your account manager for a link, or register for a trial at www.jamasoftware.
com

Note - If you are using the built-in MS Windows unzip tool, make sure you let the unzip process
fully complete before clicking on the “Next” button. There is a bug with this utility that allows you
to click “Next” prior to completion and can corrupt the unzipped files. 

Here are some alternative utilities: 

· http://www.7-zip.org 7Zip For Windows, download the '32-bit .exe' version -
Recommended

· http://www.winzip.com/ Winzip

Standalone Tomcat Installation

1. Stop Tomcat

2. Copy the Contour folder (and all sub folders) to your application server under the /webapps

folder 

For example: C:\Program Files\Apache Software Foundation\Tomcat 5.5\webapps\contour

3. Restart Tomcat

4. Start Tomcat (Windows Services)

Embedded Tomcat Installation

If you downloaded  Contour with Tomcat, all you need to do is run the following file at the root of
your unzipped Contour folder.  On Windows, this will open a Command window while the server
is running.  You can always configure Contour to run as a service so it starts automatically or
install Tomcat separately.

· Windows - run startup.bat

· Unix / Linux - run the startup.sh

Optional - Configure Contour to Start Automatically

Windows Environments

Navigate to your unzipped Contour folder and execute the file “install_contour_service.bat”.  This
will configure the Contour server to run automatically in the background as a Windows service and
then start the server.

http://www.jamasoftware.com
http://www.jamasoftware.com
http://www.7-zip.org
http://www.winzip.com/
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NOTE – you must be logged in as an Administrator on your PC for this to work.  

  

2.7 Web Setup Screens

After installation, open your browser to http://localhost:8080/contour (or the appropriate URL to the
server)

It may take a minute or two before displaying the first Contour configuration page

License Agreement

The first screen displays the Contour license agreement; select your type of installation..

Set Contour Configuration Location

Next, you’ll need to enter a location to store Contour configuration files

http://localhost:8080/contour
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Enter a location by selecting your installation type, or manually entering a location.  This is where
Contour stores configuration files and attachments.  Contour will create the folder if it doesn’t exist.
 You'll want to remember this location for upgrades.

Configure Database

1. If you are evaluating Contour, chose “Use Default Database & Continue”.  This uses
Contour's built in database and requires no setup or configuration.  

2. If you already have installed a database such as MySQL, select your database from the
drop down list

3. Contour will populate the database URL – though you may need to change the database
location or name.

4. Enter the database user name such as “root”

5. Enter the database password



Contour 2.5 User Guide14

© 2009 Jama Software, Inc.

Populate Database

There are two options – you can populate the database with the default set of data or load a
backup file.  For new installations, select “Load Default Data and Proceed to Login”

Step 5 - Log In
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The Contour login screen
will be displayed.  To
login, the default
administrator username
and password are:

User = admin

Password = password

Make sure to change
your password by
clicking on “My Profile”
after logging in.

2.8 Next Steps & Resources

Once you’re up and running, we encourage you to give us a call to walk through configuring
Contour to fit your team’s environment.  You can reach us 9:00 AM to 5:00 PM PST at (800) 679-
3058 or support@jamasoftware.com

Visit the Support and Community collaboration site – http://www.jamabackstage.com

Support Contacts – http://www.jamasoftware.com/support

2.9 Re-run Web Setup Screens

How do I reconfigure or rerun the database setup screens?

1. Locate your Contour home folder and either delete the file setup.properties or edit the file
and change contour.setup=true to false

2. Restart your application server

3. Open browser to Contour URL

2.10 Backing up Contour

We strongly recommend implementing an automated backup solution.  The following should be
backed up on a regular basis:

1. Database 

2. Contour configuration folder

3. Keep a copy of your custom reports in a separate version control system

4. Keep a copy of any modified files such as the editor templates file in a separate version

mailto:support@jamasoftware.com
http://www.jamabackstage.com
http://www.jamasoftware.com/support


Contour 2.5 User Guide16

© 2009 Jama Software, Inc.

control system

2.11 Uninstalling Contour

How Do I Uninstall Contour?

1. Navigate to your Contour folder and execute the file “remove_contour_service.bat”

2. Delete the Contour folder

3. Delete your Contour configuration folder if stored in a different location

3 Administration

Enter topic text here.

3.1 System Administration

The System Administrator is typically someone with technical knowledge that installed Contour on
the server and can configure additional settings such as LDAP or ActiveDirectory settings, SMTP
Mail Server and can upload custom reports.

Contour uses a special user account named "root" for system administrative settings.

3.1.1 System User - Root

Contour includes a built in special user called "root" that has access to the server settings.  Most of
these settings are not available to the organization administrator.

To login as the system user the default password is:

UserID = root

Password = password

Make sure to change this password to a secure password that you'll remember in the future.

3.1.2 Creating Organizations

This feature requires user to be logged in as System Admin

Select the Organizations Tab, then Add Organization.  You will likely only need to create a single
organization for your company.
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3.1.3 Updating your License Key

This feature requires user to be logged in as System Admin

At some point you may need to update your license key.  You’ll typically be sent your license key
via email as a large block of incomprehensible text. The text block is your key. 

1. Log in to Contour as an administrator 

2. Click the administration link

3. Select “License” tab

4. Copy the license key in the email and paste it into form. 

5. Click “update”

6. Your license information updates in the display

3.1.4 LDAP / Active Directory

This feature requires user to be logged in as System Admin

Contour includes a built in integration to LDAP (Lightweight Directory Access Protocol) which
includes Microsoft Active Directory. LDAP is a standard for user authentication and storing user
profile data, LDAP is a tool for organizations to centralize the management of user accounts.

By default, Contour doesn't use LDAP. Instead, it stores all user data in it's database and performs
authentication within Contour. When LDAP is selected as the authentication system, you're
directing Contour to authenticate against your LDAP server. 

You’ll need to log into Contour as the system administrator – “root”.  By default the password for
this account is “password”.  Select the “System Properties” tab, then “LDAP Properties”.

Configuring Contour to Use LDAP

1. Click on System Properties --> LDAP Properties

2. Check "Enable LDAP" 

3. Check "Enable Self Registration" if you'd like to enable Contour to automatically register
users at login and assign them to an organization and user group.  This is an easy way to
enable users to auto-log into Contour if you have a large base of users.

4. Select the Organization for self-registered users - typically  your company name

5. Select the user group to assign self-registered users
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5. Select either “Add AD Provider” or Add LDAP Provider” depending on if your using Active
Directory or other LDAP tools. 

6. Enter the appropriate details for your LDAP server, then click “Save”. Hint: Use the “Test”
here to check the connection.  

7. Once you have established a connection with your LDAP or Active Directory server,
administrators may search the directory for users to add to Contour.  Hint: If you select
“Enable Self Registration” then users can register themselves by logging into Contour using
their LDAP credentials. If authenticated they will be prompted to register for Contour. 

8. Once a user is created in Contour from the LDAP directory, they may be added to user
groups and given permission to access projects.  Contour will query the LDAP server to
authenticate the user’s password at login.

3.1.5 Email Server Configuration

This feature requires user to be logged in as System Admin

Contour users an email server to send outbound notifications.  To enable this functionality, you'll
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need to enter the mail server (SMTP) properties.

Configure Mail Server

Log into Contour with the system administrator “root” account.  Select the “System Properties”
tab, then select Edit on the “General Properties” tab.

Enter the values provided by your email system administrator If there is a SMTP server installed on
the same server as Contour, enter “localhost”

3.1.6 Adding Custom Reports

This feature requires user to be logged in as System Admin

Report templates that have been created and tested may be uploaded to Contour where all users
may run the report from the browser.

1. Click on the “Reports” tab

2. Select “Add Report”, the following screen will be displayed
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3. Enter a name for your new report that is visible to the users

4. Click on upload file, select your report file (.rptdesign) and upload it

5. Select the report file you've just uploaded in the “Report File Name” drop down list

6. Enter a description if needed

7. Leave “Any Organization” unless you have defined multiple organizations for your setup

8. Leave the check box “Visible to Users” checked

9. Select the report criteria / parameters that are used (if any) in your report

a) Note – checking the sortArtifact criteria will initiate a sort routine which enables reports
to display items in an order that matches the explorer view (tree).  This routine
populates the values global sort order and indent values in the database.

10. Save the new report – it will be visible in the list of reports

3.2 Organization Administration

Organization Administrators are users with rights to configure additional settings within Contour
that include:

1. Organization Settings / Company Information

2. License

3. Users
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4. User Groups

5. Permissions

6. Pick Lists

7. Set Types

8. Trace Relationship Settings

Users can be given Organizational Administration rights by adding them to the "Organization
Admin" user group.

3.2.1 Organization Settings

Enter your organization details in this section.

Organization Name: Typically the name of your company or team.  Used within Contour as well
as for reports.

Description: Additional information about your company.

Return Email: Contour sends out email notifications and needs a return address for these
emails.  Typically the Contour administrator's email address is used or a
noreply@company.

Base URL: Email notifications usually include links back to items in Contour.  The base
URL is used to create these URL's.  Enter the base URL for your Contour
installation.

Local Install - http://localhost:8080/contour

On-Demand - http://www.contourhosted.com

Example Server - http://goofy:8080/contour

3.2.2 Updating Your License Key

Your license key for Contour is a single key for your Organization and is provided to you by a Jama
representative upon your purchase of new user licenses and annual renewals.  If you have
forgotten your license key or need a new one, please contact Jama support.

As an Organization Admin, you can update your license key within Contour by selecting "Admin"
and then the "License" tab.  You will copy and paste your new key in the field where it says "Paste
License Text Here".

http://localhost:8080/contour
http://www.contourhosted.com
http://goofy:8080/contour
http://www.jamasoftware.com/support.htm
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3.2.3 Setting up Users

You’ll need to have administrative rights to create users within Contour.

Add a New User

1. Click “Admin” link, select the “Users” tab

2. Click “Add User”

3. Fill in all required fields

4. Note that User ID must be unique so using an email address is recommended.

On Demand Users - We strongly recommend using email addresses for user names as your
organization’s user names must be unique within our global user database.

5. Click the “Save” button

6. If you selected to have an email sent to the user, they will be notified of their user ID, password
and URL to log into the system

7. You are returned to the list of users

Editing User 

1. Click “Admin” link, select the “Users” tab

2. Select “Edit” to open user details

3. Make desired changes

4. Click “Save”

Deactivating User

1. From the “Users” tab, select the “Deactivate” link
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2. Inactive users will not be able to log into Contour until they have been reactivated by and
administrator.

Note: You cannot delete users as Contour tracks events by user and deleting the user would not
allow this type of auditing. 

3.2.4 Setting up User Groups

User groups are assigned access to specific projects and rights within Contour.  This enables

scenarios such as a group of users assigned read only access to one project, yet assigned edit rights

in others.

User groups are global within an organization and are created by Organization Admins.   Once a User

Group is created, users may be assigned.  

1. Click on “Admin” link in the Contour header (This is only visible if you have administrative rights)

2. Click on “User Groups”
3. Click on “Add Group”
4. Enter the name such as “Project Managers”, or “Analysts” etc.

After a User Group is created, you can create or edit users and assign them to the group, and enable
access to projects.

3.2.5 Configuring Permissions

Features and access to Contour is defined by the user group(s) that a user belongs to.  Contour
has a number of pre-defined user groups.

Read related topic: User Licensing

Project permissions allow administrators to allow user groups access to the project.  User groups
are global across the organization and must be added to a project to allow the users within the
groups access. 

If you’d like to have a group with specific permissions only to one project - create a group from the
organization admin screen with the name of the project appended to it - such as
Project1UserGroup.

Contour stores users in an internal database by default or can connect to an external LDAP or
Active Directory user database.   Users may be assigned directly to one or more projects or may be
assigned to user groups, which are assigned to projects.

Steps to setup users and security: 

1. Create user groups (This is optional but is faster than configuring security for every user)

2. Assign users to one or more groups

3. Open projects and assign users and groups access rights
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Access Level Description

System Admin / Root Reserved only for system configuration and uploading reports. 
This account does not have access to work on projects.

Administrator Provides access to all projects within an organization as well as
ability to configure the organization and manage security.

Manage Project Allows users full control over a specific project or all projects
when assigned at the Organization level.  Users or Groups with
this role have access to the project settings functionality.

Create/Edit – Project Level Provides visibility to project and may create, edit and delete
items within the project.    Users with Create/Edit and but not
Manage Project must have the permission Read assigned.

Read – Project Level Provides rights to read project data, create filters and leave
comments.

Manage Set Permission currently provides an assigned user with the ability
to Create/Edit and Read a items within a Set.  Future plans
include the ability to configure a set similar to configure project.

Create/Edit – Set Level Assigned will have visibility to project and may create, edit and
delete items within the assigned set.  Users with Create/Edit and
but not Manage Set must have the permission Read assigned.

Read – Set Level Assigned have rights to read set data, create filters and leave
comments.

No Access While not a specified permission within a project or set, denying
access to a User or Group is attainable by not assigning any of
the above permissions.

3.2.5.1 Setting Permissions

Permissions may be set through the “Admin” link which provides access to the organization and all
projects, or at the individual project level through “Configure Project”.

To set permissions, select the desired level in the project hierarchy from the list, then select “Add
User” or “Add Group” to add users and groups and define permissions for the project.
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Permissions and Licenses

The license type assigned to a user may override the assigned permissions.  If a user has a Read
Only license, or a Floating License that is in Read Only mode, the user will not have the ability to
Manage Project a project or Create/Edit items.

A user with a Read Only license and Administrator permissions will continue to have access to
Project and Organizational configurations but she will not be able to Create/Edit items.

Inherited Permissions

Permissions are inherited from higher levels in the organization/project structure.  For example, if
you assign a group access at the organization level, all projects and sets within the organization will
inherit the permissions.  The source of a group’s access is indicated by the Inherited column. When
a row contains that value “True” and has a green highlight the group has received its permissions
from a higher level.  

“Override” provides the ability to adjust inherited permissions or remove access to a project or set
completely by unselecting all permissions.

“Remove” will perform different actions depending on the Inherited column’s setting.  When the
column indicates that the permissions are inherited “Remove” will revert the permissions back to
the original inherited permissions.  When the column indicates that the permissions are not
inherited “Remove” will completely remove the group or user from a project or set.

Precedence of Assignments

Users can be assigned to one or more groups that may contain conflicting permissions.  The
system resolves potential conflicts by applying the highest level of access available to an assigned
group or user.

Permissions Example

Contour contains five users: Homer, Marge, Lisa, Bart and Maggie.  Homer and Marge belong to
the group Project Management while Lisa and Bart belong to Analysis.  Maggie belongs to two
groups: Analysis and Quality Assurance.

All groups are assigned to the project level.  The screenshot shows that the groups and
permissions assigned at the project level have been inherited by the set Test Cases.  The Manage
Set column indicates that the group or user has the ability Create/Edit or Read set items.

Maggie belongs to two groups (Analysis and Quality Assurance) that have different permissions. 
Contour will give Maggie the access available in the group Children since it has a higher level of
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permissions.

Here the group Analysis has its inherited permissions overridden to remove the group’s ability to
edit items within the set Risks.  The change from the default access is indicated by the Inherited
column value showing “false” and the removal of the row’s green highlight.  To reset the group’s
inherited permissions the administrator would select the “Remove” option.

This screenshot indicates that Maggie has been added to the Risks set individually with Create/Edit
and Read permissions.  The system will provide Maggie with the highest level of permissions for
the set providing her with the ability to Edit items in the Risks set even though both of her groups
cannot.

3.2.6 Customizing Pick Lists

This tab allows organization pick lists to be customized and new pick lists created.  The majority of
Contour's pick lists are defined and managed at this screen.

Creating New Pick Lists

Pick lists may be created and associated with either existing fields or custom user fields. For
example if you create a new type of item called “User Requests”, you may want to have a unique
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drop down list called “User Request Status” with different values from any other pick lists. 

1. Click on Admin

2. Select the “Pick Lists” tab

3. Click on “Add Pick List”

4. Enter a name (for display) and description(internal)

5. Save

Editing a Pick List

Click on “Config” in the Action column

6. Select a row

7. Use the icons to make any changes

8. Repeat process as needed

Pencil Edit List Item

Flag Mark item as default

Arrow Up Move up in list

Arrow
Down

Move down in list

Red X Delete

Plus Sign Add New

Deleting Pick Lists

Note: Once a pick list item has been used (assigned) by an item it may not be deleted as that item
(even when deleted) is archived and retained as part of the project history. 

3.2.7 Customizing Item Types

This feature requires Organization Admin rights

You may need to modify the existing artifact types within Contour.  For example, you may want to

remove fields from a requirement or add fields to a use case. 
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Changes to artifact types will affect all projects within an organization so you can define a requirement

once and all projects will have access to that type. You can create additional types if you need more

than one type of artifact.

1. Login to Contour as an organization administrator (not root)

2. Select Admin

3. Click on the “Artifact Types” tab

3.2.7.1 Modifying Fields

1. Click on “Config” for the artifact you’d like to modify

2. To reorder fields, use the “Up” and “Down” links in the Action column

3. To remove a field, select “Delete” from the Action column. Note this will not physically delete the
field and data; it will just remove it from being displayed on the form.

4. To add a field, choose the field you wish to add from the drop down list then click the “Add Field”
link.

3.2.7.2 Modifying Artifact Name & Components

1. Click on the “Edit” link for the artifact you’d like to modify

2. Change the name and description as needed

3. Choose which components to include when the artifact is displayed

http://www.jamasoftware.com/videos/custom_type/custom_type.html

3.2.7.3 Configuring What’s Included in a Folder

A folder is architecturally the same as an item – but displays child items in the Sub-Items panel and
can be configured to display a different set of fields from an item.  You can configure what fields
are displayed in folders by opening the “Admin” screen (Click on the link in the application header
titled “Admin”, then click on the “Item Types” tab.

You can then edit each item type and configure which fields are displayed on folders – for example
if you wanted to add the field “Status” to be displayed on folders within Requirements, you would
check the box titled “Display in Folder” as shown below.
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3.2.8 Setting up Email Groups

Email groups are lists of users whom can be notified when certain activities take place - such as

saving a new version of an artifact.  When you create email groups, they will be displayed when an

item is added or edited and you may choose to “Push” an email notification out to the group.

3.2.9 Unlocking Locked Items

Administrators have the ability to view "All Locked Items" on their profile.  You can override and
unlock items if they have been inadvertently locked or the user isn't available.

3.2.10 Customizing the Rich Text Editor Templates

Templates provide a quick and consistent way to speed the data entry process when using the rich
editor within Contour.   Templates are stored as HTML text within an XML file. Templates can be
modified and added using any text or HTML editor. 

Editing Templates

To edit the template file, open the following file: {contour directory}\js\FCKconfigs\fcktemplates.
xml 

Here is an example of the XML file with the start of a template higlighted. 

<Templates imagesBasePath="fck_template/images/">
  <Template title="Standard Use Case" image="template1.gif">
    <Description>Typical use case with main and alternate flows</Description>
      <Html>
        <![CDATA[
       <p>Use Case Title</p>
       <table border="1" width="100%" id="table1"
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The HTML text of the template is wrapped by the CDATA tags. You may cut and paste the HTML
text between these tags into an HTML editor to modify, or if you are familiar with editing text HTML
files, you can make changes directly to the XML file.

Overriding Templates File - Reccomended 

As an alternative to editing the template file, you can create a copy and direct Contour to use this
file. 

Edit the file {contour}\js\FCKconfigs\contourFCKEditor.js and update the following line: 

FCKConfig.TemplatesXmlPath = FCKConfig.EditorPath + ‘../FCKconfigs/fcktemplates.xml’ ; 

Adding Templates

Note: if you want to include a preview image of the template, use your favorite image editor to
create a screen capture of the template and resize to a width of 100px by 70px. 

Template preview images are stored in: {contour}\js\FCKeditor\editor\dialog\fck_template\images 

To create a new template, copy an existing template section, everything from the <Template
title=”Standard Use Case” image=”template1.gif> tag to the closing </Template> tag. Then, you
can update the template name, description and image. 

Create your HTML template in your choice of editor, MS word or other tool that creates HTML files.
Replace the text between the CDATA tags with the HTML code for your template. 

Activating Changes

Contour caches the templates for improved performance so you’ll most likely need to restart the
Contour server to ensure the changes are visible to users. 

Updating Contour

You'll need to make a copy of your edited templates.xml file and store it outside the /Contour
directory.  After updating Contour, copy your modified templates file back to the directory.

3.2.11 Integrations

3.2.11.1 Selenium Integration

Selenium http://selenium.openqa.org/ is an open source test automation tool for web applications.
Tests run directly in the browser like real users would use the application. Selenium is not used for
testing desktop or client-server applications.

Integration with Contour enables teams to store automated test cases within Contour, trace from
requirements and other artifacts to the test cases, then execute and return the results back to
Contour.

http://selenium.openqa.org/


Administration 31

© 2009 Jama Software, Inc.

3.2.11.1.1  Selenium Setup

Download the Selenium WAR file.  You will need to have Tomcat running on the same server as
the application you wish to test.  Copy the selenium-core.war file from the Selenium Integration
Pack into the webapps directory of your Tomcat install.

Testing Your Selenium Install

· Navigate to the Selenium install (e.g. http://10.0.0.158:8080/selenium-core/)

o Replace the server IP address with the one you’ve installed on

· Click Set up Selenium Proxy

· Enter the URL for Contour (e.g. http://10.0.0.125:8080/contour)

· Return to the main screen and click on the Selenium TestRunner link.

· Press the “Go” button in the top left frame to load the default test files.

· Press the “Run All Tests” green arrow (  ) in the Selenium TestRunner. 

· Selenium will run through its default tests, and you should see the following: 

· Selenium is now setup on your test application’s server.

3.2.11.1.2  Contour Configuration

Once you have a valid Selenium instance running on your test application server, you need to configure

Contour to expose the Selenium controls on your test cases

We recommend creating a new item type to be used for this purpose – or you can just add the

Selenium component to your existing test item type.
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Creating Test Item Types

· On the main page of Contour, click on the Admin link.

· Under Set Types click Add Type.

· Name your new item type (e.g. Web Tests).

· Under Components, be sure to have both Test History & Selenium Test checked.

· After saving the type, navigate to the project that will contain the tests.

· Create a new Set, and select the type you just created (Web Tests).

· Name the set something similar, like MyTestApp Web Tests.

You now have a place to store all your tests utilizing Selenium.  Next, you need to add the server

locations to that project.  

Configure Selenium URLs within the Project

· Click on the Project with your new Test Item set.

· Go to Actions -> Project Setup

· Under the Pick Lists tab, select Selenium Test Runner.

· Add a new item with your Selenium URL  (e.g. http://10.0.0.158:8080/selenium-core/)

· Now select Test Application Base URL from the dropdown.

· This time add the Base URL for your test app (e.g. http://10.0.0.125:8080)

Now you are ready to create some items in your new set (MyTestApp Web Tests).

Adding some Test Items

· Select Add New... and create an item under the Project that contains your tests.

· Select the new set you created

· The description field will hold the source of your actual Selenium Tests.

o Note: if you are using the rich text editor, you will have to click on the Source button before

you paste your Selenium Test source code.
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You can also write the selenium tests directly in the rich text editor using the table format.  To learn

more about this visit the open QA website.

3.2.11.1.3  Running an Automated Test

With your items setup, you are ready to run a test in contour, and have it logged in the Test Results
tab of your Test Items.

Running an Auto Test

· On your Test Item, click on the Selenium tab at the bottom of the pane.

· Select the appropriate Target Application Base Url for the app you are testing.

· Select the test runner that is located on that same server.

· Click the Run Auto Test button
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Selenium will load in another window and the test will be run.  After it has completed, Contour
automatically loads the test result into the item’s Test Result tab.

4 Working in Contour

Enter topic text here.

4.1 Basic Concepts
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4.1.1 What is Contour?

Overview:  Contour is a Web-based application designed to help organizations build great
products.  These products can be standalone software applications, physical products with
embedded software or internal IT systems.  Organizations use Contour for managing a range of
product development projects.  These projects tend to be complex with many requirements and
involve teams that are large and distributed geographically.  As a Web-based application, Contour
provides organizations a collaborative way to stay connected during the development process.

Benefits:  The functionality of Contour centers around three key needs:

1. Capturing customer needs

2. Communicating what to build 

3. Staying on top of change

Process:  Whether you’re using Agile, Iterative, Waterfall or some hybrid of methodologies,
Contour can be customized to fit your process.

Options:  Contour is available as software you install and manage internally or as a hosted service
that Jama manages for you.  The functionality is the same and this User Guide applies to both
options.  Based on what you’ve purchased, your organization is using:

· Contour On-Site – download, install and manage Contour behind your own firewall.

· Contour On-Demand – have Jama manage Contour for you as a fully hosted service.



Contour 2.5 User Guide36

© 2009 Jama Software, Inc.

See "Exploring the Contour Workspace" for more information.

4.1.2 What is an Organization

Don’t worry this isn’t some long philosophical dissertation on management theory.  An
organization as it applies to Contour represents the entire group of users who have access into
your Contour account.  

Depending on what you’ve purchased and how you’d like to configure Contour, your organization
could be your team or your entire company.  In terms of data, your organization embodies all the
Users, Projects, Items and all the other related data you have in your Contour account.

Note:  Contour is multi-tenant and companies based on their size and structure can have multiple
organizations created if needed. Contact Jama if you think you need separate organizations.

To manage your Contour organization, you will need at least one Organization Admin.  An
Organization Admin has full administrative control of Contour and has the highest level of
permissions.  You can have as many Organization Admins as needed. 

4.1.3 What is a User?

There are three types of Users – Named, Floating and Read Only.  Based on the Contour user
licenses that you’ve purchased, your Organization Admin will set each user at one of these types.

Named User - Designed for one person with editing rights and full access to Contour 24/7.  Best for
team members who are active users managing Items within Projects on a daily basis.

Floating User - Designed for team members who need editing rights and occasional access to
Contour to be able to add or edit items, but don’t require 24/7 access as a named user has.  This
license type allows for multiple people to share a license, but it’s limited to only one user accessing
Contour at a time per floating license that you’ve purchased.  As an example, you could have 10
people sharing 3 floating licenses, but only 3 people at any given time can access Contour.  In the

http://www.jamasoftware.com/support.htm
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scenario of when you reach capacity, any additional floating users logging in will be limited to
read-only permissions.

Read Only – Also called “Collaborator licenses”, read only users are designed for stakeholders,
customers and other people within your organization that need visibility into a project but don’t
need editing rights.  Read only users can view items and provide comments.

Note:  Each person regardless of license type will have a unique login (username and password)
and your Organization Admin will set license types in the Users tab within the Admin  Settings.

4.1.4 What is a Project

A Project is a way to organize and manage information within Contour.  A Contour project is a
collection of Sets, Items, Filters and Releases, and is defined according to your organization's
needs.

When you log into Contour, it will remember the last project you were working on and load it
along with all of its Sets and Items.  For a quick snapshot of activity on a project, view the
Dashboard tab.

To switch to another project you have rights to access, select the “Change Project” button.
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Note:  In order to create a new project, you must be an Organization Admin.

User permissions can be set at a project level, so specific user(s) can have full editing and
configuration rights within specific project(s) and not view other projects.  See Administration help
for more details.

4.1.5 What is a Set?

A Set in Contour is a group of Items of the same type.  For example, you may create a set called
“Software Requirements” and within that set you could have multiple requirements:  Requirement
1, Requirement 2, Requirement 3 and so on.  You might create a separate set to contain Use Cases,
Story Cards, Defects etc.

Each set can only contain a single type of item.  For example, you can not mix requirements with
use cases as they have different fields.  You may also have multiple sets of the same type.  For
example it's common to have a set of Business Requirements and Functionality Requirements.  

Items can easily move or be copied between sets of the same type, so you could move a Business
Requirement to a Functional Requirement - but not to a Use Case.

Note:  Your Organization Admin can add, configure and customize the sets you use in Contour.  

See Adding a Set for more information.

4.1.6 What is an Item?

You can use Contour to track different types of information based on the projects you’re
managing. Depending on how your organization uses Contour, an item could represent a feature,
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a requirement, a use case, a test case, a defect, and other items you need to manage and track
within the development process.

Common items managed within Contour include:

· Features

· Requirements

· Use Cases

· Test Cases

· Tasks

· Defects

Each type of item is grouped in a Set and has a template with specific fields to complete when
adding new items.  See “Adding an Item” for more information.

Note:  Your Organization Admin can customize the types of Items and corresponding fields you
use in Contour.  See “Customizing Fields” for more information.

4.1.7 What is a Folder?

Within a project, folders provide an additional way to organize items.  You can have multiple tiers
of folders based on how you want to manage the hierarchy of Items within your project.  

For example, on a product development project, you may have multiple folders within your set of
requirements.  One folder for “software requirements”, another folder for “hardware
requirements”, another folder for “functional requirements”.  The Explorer View provides a
hierarchical view of your folders, sets and items, allowing you to drill-down to find items.  See
“Adding a Folder” for more information.



Contour 2.5 User Guide40

© 2009 Jama Software, Inc.

4.1.8 What is a Release?

Common in software development, a release is a group of Items that are developed together, and
mapped to a specific completion (release) date.  

Within each project in Contour, releases can be planned for multiple iterations over time.  As you
plan your releases within Contour or if you need to re-prioritize items between releases,  you can
simply move an item or multiple items from one release to another by dragging and dropping
them within the Releases View.

See the “Releases” chapter for more information on how to plan releases in Contour.
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4.1.9 What is a Filter?

A Filter in is a way for you to search for similar information based on the fields within Items and
then create a filtered list of those items.  For complex projects with hundreds or thousands of
items, filters become a time-saving tool for getting to the most relevant items you are working on. 
For example, a common use is to create a filter for tasks that are assigned to you.

Filters can be saved for you to reference later.  You can also share your filters with other people. 
Saved filters are accessible in the Filters View.  The filters marked with an asterisk (*) are set as
public filters, meaning they are viewable by others within your organization.

See "Adding a Filter" for more information.

4.1.10 What is a Relationship?

“Welcome to the Jama Loveline, how can we help?”  Just kidding, this isn’t about personal
relationships.  

In Contour, relationships are used to link Items together that are related – what is known as
“Traceability”.  By creating relationships between items, Contour allows you to easily assess the
impact a change to one item can have on other items within the project.  This feature will help you
manage change effectively and keep your team in sync during development.

When you create relationships, you can then analyze the impact a change will have on other items
both direct and indirectly – what is known as “Impact Analysis.”

Relationships can be either upstream or downstream from an item.  And, within Impact analysis
you can see the entire picture of all items affected whether directly or several steps removed.  It’s
like seven degrees of separation, but instead of Kevin Bacon, it’s a new feature you're developing.
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Note:  You can relate Items within the same project or across multiple projects if needed.

See the "Traceability"chapter for how to add relationships and run impact analysis.

4.1.11 What is a Tag?

Like many Web 2.0 applications, Contour provides you the ability to assign your items a "tag" or
multiple tags, which are like keywords or category labels. Tags can be an alternative way to
organize and find items which have something in common. 

In Contour, you will see your tags displayed in a pane in the lower left.  You can choose to display
them in a tag cloud view or a list view.

See “Adding a Tag” for more information.

4.1.12 What is a Tab?

Similar to the latest versions of Web browsers, Contour uses Tabs that open along the top of the
application to allow you to have several items open at once and easily work across items, which
can be a time saver.
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By default, when you login you will see the Welcome tab for educational content and the
Dashboard tab that provides a snapshot of the latest activity of the most current project you're
working on.

As you select your first item to view or edit, you will see it open in a new tab.  When you select
another item, Contour assumes you're done with the first item and will open the subsequent item
in the same tab.  

To open an item in a separate tab, you will use the right click function and select "Open in New
Tab". 

4.2 Getting Started

4.2.1 Supported Browsers

Jama Contour is a Rich Internet Application (RIA) that uses standard web-browsers as the client. 
Contour utilizes a technology called Ajax and uses JavaScript extensively, so you’ll want to use the
most up to date web browser possible for the best performance and user experience.

Web Browser Support

Browser Supported? Notes

Microsoft IE 6.1 Yes IE 6 which is almost 7 years old will work with
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Contour – though there are a number of reasons
to upgrade.  We strongly recommend upgrading
to IE7. Here are some known issues.

· Transparent PNG images are not displayed
correctly so visually, Contour in IE6 is not very
attractive

· Speed – IE6’s JavaScript engine is old and slow
so the user experience with IE6 may not be
acceptable

· Caching Issues – users have reported
intermittent caching issues with IE6 that can
cause problems rending pages correctly. 
Setting the browser to check for a new version
of the page every visit can help.

Spell-check is provided by the IESpell plug-in. 
Licenses are free for individual users and available
for purchase.

Microsoft IE 7 Yes Recommended version for organizations that are
required to use IE

Mozilla Firefox 3 Yes Suggested browser for the overall best user
experience.

Apple Safari Unofficially

Google Chrome Unofficially Provides the fastest user experience but is a
relatively new browser.

What do you mean by unofficially?  Both Safari and Chrome are based on Webkit which we will be
adding as a supported browser.  We haven't fully integrated these browsers into our testing yet but
we do have team members using them internally.  Run into trouble with your browser?  We'd like
to know.

4.2.2 Logging into Contour

To log into Contour, open your web browser and enter the URL provided by your administrator:

Local Installations

For local installations on  your computer, the default URL is http://localhost:8080/contour 

Contour On-Demand

Jama's hosted service can be accessed by clicking the login link from www.jamasoftware.com.
 

http://localhost:8080/contour
http://www.jamasoftware.com
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If you’ve just installed Contour with the sample data, you can log in as the “Administrator” and start
creating users and configuring the system.

The default user and password are:

User ID:  admin

Password: password

System Administrator / Root Access

Contour has a special user account reserved for system administration.  This account is used to
configure server wide settings such as LDAP / Active Directory configuration and the SMTP mail
server.

To access system settings, the default settings are:

User ID: root

Password: password

Read this topic to learn more about system administration
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4.2.3 Remember Me

Checking "Remember Me" will save your login information to a cookie on your computer.  

This is for convenience as the next time you access Contour, you'll bypass the log in screen and be
taken directly into the application.  Contour will remember your login information regardless if you
close the browser or click the log out link.

To have Contour forget your login, clear your cookies within your web browser.

4.2.4 Exploring the Contour Workspace

This screen capture of Contour shows at a glance the five primary panes within the Contour
Workspace.  You can expand collapse and resize these panes any time based on how you prefer to
work.  

1. The left pane includes tabs for three main views: Filters, Explorer and Releases

2. The center pane is where you view the details of specific Items.

3. The right pane is the where you can add Relationships for traceability.

http://en.wikipedia.org/wiki/HTTP_cookie
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4. The bottom pane is where you’ll manage information associated with an Item such as
Comments, Relationships, Attachments, Versions and Activities.

5. This is your Tags cloud to navigate to Items grouped by keywords.

For a guided tour through Contour, watch the overview video.

4.2.5 Managing Your User Profile

To manage your user profile, click on the “Edit Profile” link in the upper right of Contour. 

Under “My Details”, this is where you can change your password and edit your user settings such
as your user ID, location and contact information. See “Changing Your Password” for more
information.

From within “My Email Notifications” you can update the frequency you wish to receive email
alerts and see the complete list of the items that you have subscribed to.  See “Subscribing to
Email Alerts” for more information.

From within “My Locked Items”, you can view a complete list of the items you have locked,
meaning others can’t edit it.  See Locking an Item for more information.

http://www.jamasoftware.com/videos.htm
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4.2.6 Changing Your Password

Passwords may be changed by individual users by selecting the “Edit Profile” link and clicking on
the “change password” button.  Alternatively, if you have administrative rights, you can change
user passwords by selecting, “Admin”, then selecting the “Users” tab.

Passwords may be any combination of numbers, letters or even a phrase.

4.2.7 Forgot Your Password

If you forget your password, contact your Contour Administrator.  They will have rights to reset
your password on the user management tab.

Contour On-Demand

For On-Demand users, you may either contact your Contour Administrator or Jama Support.

4.2.8 Logging Out

This may sound like a very basic function, but it’s important to remember to do if you’re a floating
user and your license of Contour is shared with other floating users.  The “Log Out” link is located

http://www.jamasoftware.com/support
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in the upper right of Contour.

4.2.9 Getting Help

Do you have a question that's not covered in the Contour User Guide? Try the online customer
forum: Jama Backstage

Or, you can get additional Jama support resources at http://www.jamasoftware.com/support

Other Services:

Our goal is to build Contour to be as easy as possible for everyone to learn, but if you have a large
team to train quickly, need to integrate Contour with other tools or want to go beyond the basics,
Jama offers training courses and other professional services to help you be more successful with
Contour.

Training: http://www.jamasoftware.com/training.htm

Professional Services: http://www.jamasoftware.com/services.htm

4.2.10 Support FAQ

Here's a snapshot of the 5 most frequently asked support questions:

Q:  I’ve just finished my upgrade and I’m getting HTTP 500 errors, popup errors, or strange
behavior.  Did I do something wrong?

A:  The most common errors after an upgrade are related to Tomcat’s cache not being cleared
properly.  To resolve these issues, simply stop Tomcat, and delete the following directory: 
#TOMCAT_HOME#/work/Catalina/localhost/contour 

Q:  There are items that are not showing up in Contour.  What can I try before calling support?

A:  Contact your Contour System Admin and have them run the indexing under the Contour Root
User.

Q:  I want to back up my database, should I use Contour’s backup feature or something more
specific to my type of database?

A:  We highly recommend doing a scheduled backup of your database using whatever backup
software is provided by your database type.  Contour backups are meant to aid in migrations, but
should never be considered a “safe” form of backing up data.

http://www.jamabackstage.com
http://www.jamasoftware.com/support
http://www.jamasoftware.com/training.htm
http://www.jamasoftware.com/services.htm
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Q:  I’m having some problems getting my reports to work properly.  What sites do you
recommend for learning more about BIRT reporting?

A:  Check out these web sites:

http://www.birt-exchange.com/modules/vbulletin/

http://www.eclipse.org/birt/phoenix/deploy/reportScripting.php

http://www.nabble.com/Eclipse-BIRT-f2267.html

Q: How do I enhance the speed of Contour?

A: Contour is optimized for the latest versions of web browsers:  Firefox 3, IE 7, Safari 3 and
Google Chrome.  If you can within your corporate environment, we recommend you upgrade
your web browser to enhance performance.

Download the latest versions:

Mozilla Firefox

Microsoft Internet Explorer

Apple Safari

Google Chrome

4.3 Project Setup

4.3.1 Creating Projects

After logging into Contour, the project home screen is displayed.  If you have rights to create projects

you will see the “Project…” button and the “Project Settings” option.

Select “Project Settings”, then from the “Add” menu chose “Add Project” or “Add Folder” to create the

project structure that best suits your organization’s needs.  For example, you might create a group

called “Product Line” with projects for major releases.  You might also create a project to hold a library

of common requirements or documents.

http://www.birt-exchange.com/modules/vbulletin/
http://www.eclipse.org/birt/phoenix/deploy/reportScripting.php
http://www.nabble.com/Eclipse-BIRT-f2267.html
http://www.mozilla.com/en-US/firefox/
http://www.microsoft.com/windows/products/winfamily/ie/default.mspx
http://www.apple.com/safari/
http://www.google.com/chrome
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4.3.2 Configuring Projects

Enter topic text here.

4.3.2.1 Project Details

The Project Details tab stores high level project information such as name, description, completion

date etc.  To edit details:

1. Select a project, then click Project --> Configure Project --> Details

2. Make changes as needed.

4.3.2.2 Project Settings

The Project Settings tab stores project wide configuration options.  To edit details:

1. Select a project, then click Project --> Configure Project --> Settings

2. Make changes as needed.

Version Items Turns automatic versioning off and on.  You may want to turn versioning
off while initially creating and organizing the project. 

Display ID in Project
Navigator

Toggles displaying the artifact ID’s in the explorer (tree) view

Max items displayed in
explorer tree

Sets the maximum number of items that will be displayed when using the
explorer tree view.  After an import there may be thousands of items so
this can be configured to improve performance when working with large
data sets.

Max items displayed in
grid views

Sets the maximum number of items (rows) that may be displayed in the
enhanced grid view.  The number of items able to be displayed depends
on the memory available to the Contour server and client.

4.3.2.3 Project Sets

Enter topic text here.
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4.3.2.4 Project Releases

Enter topic text here.

4.3.2.5 Project Pick lists

This tab allows project level pick lists to be customized.  This tab functions the same as the 
organization admin pick lists, please see that page.

4.3.2.6 Project Email Groups

Enter topic text here.

4.3.2.7 Project Permissions

Enter topic text here.

4.3.2.8 Project Baselines

A baseline is a “snapshot” of the project at a certain point in time. When you create a baseline, the
system stores a baseline tag on the current version of each requirement. It is useful to create a
baseline at each significant event - for example when the requirements are complete, after change
requests, after a release, etc.   A baseline includes every item within a project.

Create, Edit & Delete Baselines

1. Select "Projects", "Configure Project"

2. Select "Baselines" tab

3. Select "Add Baseline"

4. Enter a Name and Description

5. Save -  Contour will tag the current version of each item with the baseline

Editing a baseline allows changes to the baseline name and description - it does not modify the set
of items included.

View Baselines from an Item

1. View an item’s history

2. Baseline(s) are displayed in the baseline column

Baseline Reports

Reports can provide a variety of data related to baselines such as all artifacts for a particular
baseline. In addition baselines comparisons or subsets of the baseline can be reported on as well. 
Contour includes 3 baseline reports

· Baseline Comparison - compare between two baselines

· Baseline Items - all items included in a baseline
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· Baseline vs. Current - compare between the current version and baselined version

4.3.2.9 Project Attachments

Use the attachments tab to view and manage all attachments related to the current project.

4.3.2.10 Project Tag Management

Enter topic text here.

4.3.2.11 Project Data Index

Enter topic text here.

4.3.3 Deleting a Project

1. Select the project you’d like to delete

2. Click the “Actions” menu, then “Delete”

3. Confirm that you want to delete the project

Note:  When you delete projects, Contour physically deletes the project along with all sets and
items within the project. 

4.4 Working in Projects

4.4.1 Selecting or Changing a Project

When you first log into Contour, you'll be prompted to choose a project.  The next time you log into

Contour, you'll be taken back to the last project you were working on.
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To open a new project, click the “Change Project” button.  A project selector window will open
where you can choose a new project.

 

4.4.2 Managing Requirements & Other Items

This is where the rubber meets the road.  Contour is all about helping you manage requirements in
a collaborative environment with your team.

Within Contour, requirements are managed as Items.  Other sets of items include features, use
cases, test cases, defects, etc. - essentially any type of information you need to capture in defining
the scope of your project/product, and to communicate to your team precisely what to build.  

This chapter will provide you step-by-step instructions for managing requirements and other items
within Contour.
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4.4.2.1 Adding a Set of Items

There are two ways to add sets to a project, through Project --> Configure Project and a shortcut from

the Add Item form.

Add Item Form – Clicking on any Add --> Item will open the form.  If the list of sets isn’t displayed

on the left panel of the form, click on Change Set and the Add Set button is available.

Project Configuration

To add a set through project configuration select Project --> Configure Project, then select the Sets
tab.

To add a new set:

1. Click on the “Add Set” button

2. Select the Type of Set – this list is populated with the default item type as well as any
custom types that an admin has created.

3. Edit the labels as needed

4. Enter a description (Optional)

5. Check the box “Visible in Releases” if you’d like the items in this set to be available / visible
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in the release management view.

6. Select an icon

7. Click Save

After saving the set to your project, you can start adding items and folders.

4.4.2.2 Adding an Item

Use the “Add”, “Item” button within the Filter, Explorer or Releases tab to add new items.  

If you are already working in a set, such as Requirements, Contour will assume you want to add a
Requirement. If you want to enter a different type of item, click Change Set.  Contour will open a
selection window where you can choose the set and folder to store the new item.

Fill out the form and click Save to continue working, or Save and Close to commit your changes.
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Contour displays the Version and Email Notification dialog.  The first time you create an item,
Contour enters "Initial creation" in the version notes.  You can overwrite these comments with your
own text.  When you edit items, Contour will keep track of which fields are changed and pre-enter
version notes to speed things along.  You can always overwrite the notes.

Next, select any email groups that you'd like Contour to notify about the new item or change.
Contour will send an email with the version notes, details of the change and a link back to Contour.

Click Commit to save your changes and return to Contour.



Contour 2.5 User Guide58

© 2009 Jama Software, Inc.

4.4.2.3 Viewing & Editing an Item

You can view an item by selecting it in the Explorer pane or double clicking or right clicking on
items in a grid view.

The Views menu provides access to open Relate  to create trace relationships, Impact Analysis,
Quick Reports and adjust the layout of the sub-tabs.

The Actions menu provides access to:

· Email Notifications

· Add Related - provides a seamless way to add a new item that is related to your current
item.  When you are working on a requirement, you can add a related use case and test
case “on the fly” with a relationship created automatically.  Another scenario is working
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through a test case; you can add related defects “on the fly”.

· Find Me – clicking on Find Me opens the current item in the Explorer view.  This is helpful if
you’ve navigated to an item from search results, filter results or tags and want to know the
location of the item within the tree view.

· Email Link – Clicking on Email Link opens a new email (using your default email client) with
a link to the current item.

· Edit the current item

· Copy - The copy function provides a way to clone a requirement or other item.  You can
choose to include a permanent link back to the originating item as well.  This is helpful if
you are decomposing a requirement and want to retain a link back to the item it was
spawned from.

· Delete the current item

Each item in Contour has a sub-tab section for accessing related content such as discussions, trace
relationships, attachments, tags and history.  For certain items, such as test cases, you’ll also see
tabs for test results.

4.4.2.4 Using the Rich Text Editor

Contour provides a rich text editor for writing requirement descriptions, use cases, test cases, etc. 
By default Contour has the rich text editor turned on.  If you prefer, this can be turned off by
editing the description fields in the Item Types tab of the Admin screen.

While the rich text editor is generally an advantage over plain text, you may want to turn it off if
using your own reporting engine or want to tightly control the data entered in these fields.



Contour 2.5 User Guide60

© 2009 Jama Software, Inc.

Considerations when using the Text Editor

Advantages Disadvantages

· Easily create rich, descriptive documents

· Embed images an hyperlinks within
descriptions

· Use tables for layout

· Templates speed data input

· Undo / redo capabilities

· Spellcheck is available

· Reporting can be difficult as each rich text
section has its own set of styles so controlling
overall look and feel can be difficult.

· Tables do not display when reports are
exported to PDF or MS Word format.  This
capability relies on underlying conversion
software and may be available in the future.

· Most 3rd party reporting tools cannot display
rich text (HTML) properly so using the
provided custom report designer would be
necessary. (Or the rich text editor may be
turned off).

· Integrations with 3rd party applications may
not be able to accept rich text (HTML) data.

4.4.2.4.1  Inserting Images

There are two ways to include images into the editor.

Upload an image directly into editor
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1. Click on the picture icon, a popup window is displayed

2. Select the Upload tab

3. Browse for a file and select it

4. Click the “Send it to the Server” button

5. One the image is uploaded the image preview window is displayed with the URL to the
image on the server

6. Make any adjustments and click “OK”

NOTE – To enable images to be included by the reporting system including 3rd party converters to
PDF and Word, we are required to provide the full path to the image file.  If you move Contour to a
new sever location or modify the server name, you’ll need to edit your image files to reference the
name change.  We are working on a solution that allows relative paths.

Link to Image URL

1. Navigate in your web browser to the image you’d like to include

2. Right click on the image and select “Copy Link Location”

3. Within Contour, open the editor

4. Click on the image icon (mountain)

5. Paste the link location into the URL of the image

6. Click Save and the image will be displayed within Contour

4.4.2.4.2  Using Templates

Templates are pre-written text or documents that can be quickly inserted into the editor.  This
allows you to create consistent items such as Test Cases or Use Cases and speed entry.

To use a template, click on the templates button as shown above, then click on a template to insert
into the rich text editor.
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Contour provides several templates for use with the text editor.  We currently include:

1. Use Case – Basic

2. Use Case – Document Style (longer with descriptive text on how to complete)

3. Test Case – Basic (Tabular test case for manual test scripts)

4. Agile Story Card

5. Product Competitor Template

If you’ve installed Contour, you may edit or add templates.  On-Demand users please contact Jama
for template requests.

4.4.2.4.3  Spellcheck

Contour uses IESpell for spell checking in Internet Explorer and Mozilla’s built in spell check for
Firefox. 

IESpell

The first time you select the spell check button in the rich text editor tool bar, you’ll be prompted to
install IESpell. Accept to install and a spell check extension is installed into Explorer. 

You can then check spelling either by using the spell check button - or on any web page, choose
spell check from the menu item. 

Firefox

We recommend using Firefox 2.0 which includes integrated spell check. 

Other Options

If you require another option for spell checking, we offer an integrated server side spell checker
available through professional services. 
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4.4.2.5 Copying an Item

You can copy an item by selecting Actions --> Copy Item.

That will initiate a pop-up window where you can decide which assets you want to copy along
with the Item details, such as relationships and tags. Also, you will select the destination of where
you want the copied item to go within the applicable project, set and folder.

Note: You can only copy items to sets of the same item type.  For example if you have two sets of
requirements, you can copy and move between these sets, but you can not copy to a set of test
cases as the fields are different.
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4.4.2.6 Locking an Item

When editing an item, Contour will automatically lock the item so others may not make updates at
the same time.  When you commit your changes, Contour automatically unlocks the item.

You may also manually lock and unlock items.  This is useful if you wish to work on items for an
extended period of time.  To lock or unlock an item, click on the “Lock” icon in the item’s toolbar. 
If an item is locked by another user, Contour will display the user who has locked the item when
you hover over the lock icon.

Locked items may be copied.

To view all your locked items and unlock from a central location, click on the “My Profile” link, then
the “Locked Items” tab.  From here you can view a list of locked items and unlock them as needed.

Note: Administrators may unlock other users items from this screen as well.

4.4.2.7 Deleting an Item

To delete an item, open or select the item, then click Edit --> Delete.  

From the grid, you can also select multiple items for deletion by selecting Edit --> Delete Selected.

Note: When you delete items, they are not physically deleted but set to inactive and will not be
visible to users or reports.  If absolutely required, they can be re-activated through the database.

4.4.2.8 Updating Multiple Items at Once

Batch update gives you the ability to update or delete many items quickly.  After selecting one or
more items in the grid view (hold the Control Key or Shift key to select multiple items) and click on
Edit, Update Selected Items.

1. Select which fields you’d like to change by checking the checkbox. 

2. This will render the corresponding field editable. 

3. Select the desired value

4. Click “Update”



Working in Contour 65

© 2009 Jama Software, Inc.

5. The list will refresh after the update. 

OPTIONAL:  If you’d like to version this update and/or send out a notification select this check box.
A new area will appear where you can select the appropriate notification groups and add any
comments. 

Note: the comments will show in both the version history and the notification email. 

4.4.2.9 Moving Items (Drag and Drop)

Contour's user interface is very fluid and allows you to move an item around by simply selecting it
and dragging and dropping it into the new location.  This is useful for reorganizing the hierarchy of
items within the Explorer View.  Also, this is useful within the Releases View for reprioritizing items
between releases.

4.4.2.10 Adding a Folder

Folders are be used to organize items within a set.  An item may be moved between folders and
sets of the same type using drag and drop within the explorer tree or from the grid – for example,
you can move a business requirement to a functional requirement but not to a test case.  In
addition, folders themselves may be dragged around the tree.

MULTI-SELECT: To move more than one item, you can select multiple items on the grid view (right
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pane) and drag them as a group to their new location.

TIP:  Folders can be used to organize sub-requirements.  For example, if a requirement is
composed of several sub-requirements, create a folder to contain the sub-requirements.

1. Click on the tree to position your cursor

2. Select “New”, “Folder” from explorer menu

3. Enter name and description

4. Click “Save”

Note: Fields displayed on the folder may be customized

4.4.2.11 Adding Comments

The comment tab provides a way for the team to collaborate on a particular item.  If users have

selected to be notified of changes to an item or set of items, adding a comment will trigger a

notification email so they stay connected with new comments.

Users have the ability to edit and delete their own comments – but only Project Admins have rights to

edit and delete other user’s comments.

4.4.2.12 Adding Tags

Tags provide a flexible way to categorize project artifacts. Tags may be used to group items in
ways that the hierarchal structure doesn’t allow. Each item contains a tags component where tags
may be viewed and selected. To add, edit or remove tags, click on Views, Tags in the explorer
panel. 

The tag cloud view which displays the tags with the font size determined by the number of items
“tagged” – the larger the font, the more items.  A traditional list view is also available.
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Just click on the tag to view the items assigned to that tag.  

Search & Filter on Tags

For advanced tag queries, you can use the search engine or keywords box within Filters.  

Use the prefix tag: to indicate the tag field in your query.  

tag:"requirement management"  AND tag:security
tag:"requirement management"  AND tag:security (tag:"user"  OR  tag:security) AND tag:requirement

You can use the plus sign as a shortcut for the AND operator and the minus sign for NOT.

+tag:"requirement management"  -tag:security
test case +tag:requirement   +tag:security

Item Tags

Each item has a tab that displays the tags that this item has been assigned.  Click Add / Edit tags to
open the tag manager.
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Adding / Editing Tags

Clicking on Edit Tags displays a tag edit window.  The left pane displays all project tags and the
right pane displays the list of tags currently assigned to the item.  To add or remove tags, click on
the tag in either pane

4.4.2.13 Working with Test Cases

Test cases are project items that capture steps needed to test a feature or scenario within the
product you're building. Contour provides test case and test management features.  For more
complex testing requirements, you may want to integrate Contour with a 3rd party test tool. 
Contact Jama for information on integrations.

Manual Test Runner Functionality

A unique section to the test case artifact is the test history and test runner section.

http://www.jamasoftware.com/support.htm
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4.4.3 Search

4.4.3.1 Full Text Search

Contour indexes all database fields as well as the following file attachments

1. Database fields

2. Text files

3. MS Word files

4. Adobe PDF files

Security

Contour filters search results and only display items that you have at least “read only” rights to.

Performing Search Queries

1. Enter your search query in the search field. (See below for tips)
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a. Select "All" to search across all projects in the repository

b. Select "Project" to search with the current project

c. Select "Results" to search within the current results (such as search or filtered results)

2. Contour will display a list of matching results in a grid

3. Double Click on a row or select “Open” to view an item in a new tab

4. Click back to the search results tab to view other items

Searching Specific Fields

Search supports the ability to narrow the search to specific fields. For example to search only
within the name field use the field name followed by “:”

name:test

This will return results of the term “test” only looking at the name field.  

Search Query Tips

A query is broken up into terms and operators. There are two types of terms: Single Terms and
Phrases.

· A Single Term is a single word such as "test" or "hello".

· A Phrase is a group of words surrounded by double quotes such as "hello dolly".

Multiple terms can be combined together with Boolean operators to form a more complex query
(see below).

Search supports single and multiple character wildcard searches within single terms (not within
phrase queries).

· To perform a single character wildcard search use the "?" symbol.

· To perform a multiple character wildcard search use the "*" symbol.

The single character wildcard search looks for terms that match that with the single character
replaced. For example, to search for "text" or "test" you can use the search:

te?t

Multiple character wildcard searches looks for 0 or more characters. For example, to search for
test, tests or tester, you can use the search: 

test*

You can also use the wildcard searches in the middle of a term.

te*t

Note: You cannot use a * or ? symbol as the first character of a search.

AND, OR & NOT
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Boolean operators allow terms to be combined through logic operators. Search supports AND,
"+", OR, NOT and "-" as Boolean operators (Note: Boolean operators must be ALL CAPS).

OR - The OR operator is the default conjunction operator. This means that if there is no Boolean
operator between two terms, the OR operator is used. The OR operator links two terms and finds a
matching document if either of the terms exist in a document. This is equivalent to a union using
sets. The symbol || can be used in place of the word OR.

To search for documents that contain either "jakarta apache" or just "jakarta" use the query:

"jakarta apache" Jakarta

or

"jakarta apache" OR jakarta

AND - The AND operator matches documents where both terms exist anywhere in the text of a
single document. This is equivalent to an intersection using sets. The symbol && can be used in
place of the word AND.

To search for documents that contain "jakarta apache" and "Apache Lucene" use the query: 

"jakarta apache" AND "Apache Lucene"

+ The "+" or required operator requires that the term after the "+" symbol exist somewhere in the
field of a single document.

To search for documents that must contain "jakarta" and may contain "lucene" use the query:

+jakarta lucene

NOT - The NOT operator excludes documents that contain the term after NOT. This is equivalent to
a difference using sets. The symbol ! can be used in place of the word NOT.

To search for documents that contain "jakarta apache" but not "Apache Lucene" use the query: 

"jakarta apache" NOT "Apache Lucene"

Note: The NOT operator cannot be used with just one term. For example, the following search will
return no results:

NOT "jakarta apache"

- The "-" or prohibit operator excludes documents that contain the term after the "-" symbol.

To search for documents that contain "jakarta apache" but not "Apache Lucene" use the query: 

"jakarta apache" -"Apache Lucene"

4.4.3.2 Filters

Filters provide a flexible way to view project items. Filters may be used to enter a query within a
project in order to display only relevant information. Once a Filter is created is can be shared with
the rest of the team. 

Selecting the Filter tab displays a list in the left hand panel of all Filters available to you.  Filters with
an asterisk * are shared filters that everyone can use. 
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Adding a Filter

Select Add --> Filter, Contour will display a form with the following fields

· Set - Choose the set of items to filter

· Keywords - Optional entry of a search query to filter text fields or advanced filters on tags

· Public checkbox - Indicates whether the 

Once you select the Set, the form will populate with the corresponding fields.  A few notes about
entering filter criteria:

· No selection means that attribute will not be included in the search query 

· Selecting “None Selected” returns only items that do not have any value selected

· If you select value X in “Status” and value Y in “Priority” this means you want all items that
have status X AND priority Y.

At this point you can Apply or Save the filter. The system will display the results of the filter and
add the filter to the system.

Editing a Filter

Selecting “Edit” from a filter in the list will show the form with the criteria pre-populated.  You can
modify the existing filter or use this filter as a starting point to create a new one. “Save as New” will
create a new filter leaving the old one intact. 

Deleting a Filter

When deleting a filter you’ll be prompted to confirm this action.  Keep in mind that if you delete a
shared filter, even if you aren’t the creator it is deleted for everyone. 

4.4.4 Trace Relationships

Traceability (also known as Trace Relationships) is one of the key benefits of requirements

management. Contour allows you to establish trace relationships between items, so you can assess

the impact that changes can have on other items.

Contour enables the creation of trace relationships between any items within the same project or

within other projects such as

1. Requirement –> Requirement

2. Requirement –> Use Case / Story Card / Design Document

3. Requirement –> Test Case

4. Use Case –> Business Rule

5. Any other combination
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4.4.4.1 Viewing Trace Relationships

The relationships tab displays all related items grouped initially by direction.  

Table View A tabular view of relationships that can be sorted and grouped.  Multiple
rows may be selected.

Visual View A card layout view that displays items in relationship to your current item.

Filter Enables you to filter the items displayed in the relationship view

Open Relate Used to create new relationships

Edit Used to edit relationship attributes

Table View (Default)

Direction Indicates the position of the related item to the current item - either
upstream or downstream.

ID The ID of the related item - clicking on the item opens it in the current tab

Name Name of the related item

Set The item type of the related item

Type The type of relationship - configurable drop down list

Suspect Indicator if the relationship is suspect.  Clicking on Clear will remove the
indicator and log the action in the activities tab

Adjusting Columns

See Using the Grid for details on sorting, grouping and adding / removing columns.

Visual View

There is also a visual view for the relationships. 
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4.4.4.2 Filtering Trace Relationships

You can adjust the information displayed in the relationships tab by clicking on the "Filter" button. 
Contour will display options to filter the results and only display a particular set, relationship type,
status or value in the notes field.

This can be helpful, for example, if you just want to view requirements related to test cases, or
requirements related to use cases.  The filter is stored in your session so as you click from item to
item, the filter remains in effect.  To remove the filter, click the "Remove Filter" text.

4.4.4.3 Creating a Trace Relationship

Creating a trace relationship establishes a directional link between two items.  The related items
may exist in the same set, project or in completely different projects.

1. From an item, click Views --> Open Relate OR from the relationship tab, click Open Relate

2. Contour will display the “Relate” panel with the current item selected on the left side,
current relationships displayed in the center in either a table view or the visual view, then a
2nd explorer view on the right to select projects and items to relate to.

3. Select an item on the right explorer view
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4. Double click on the item, or click the “Relate” button.

5. A relationship is added to the selected item

Security Implications

In cases where a user does not have rights to an item, but the item is linked to an item they do
have rights to view, the user has read only access to see that the relationship exists and can view
the item's attributes on the relationship tab.  The user will not be able to preview, open or edit the
item, just see that it exists through the relationship.

4.4.4.4 Traceability Matrix

The traceability matrix provides a visual representation of relationships within a project. This
provides an intuitive way to quickly see relationships for a set of items. For example you may want
to select a set of requirements and see which have related test cases. The matrix also helps
determine impact when a change occurs. You can quickly see what items are related and evaluate
the impact. 

To view the matrix

1. Select the "Project" menu, then "Trace Matrix"

2. When the window opens, select a set to be displayed along the left side and a second set
to display along the top, and then click “View Matrix”. 
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For large matrix’s you can single click on a row to highlight it. 

Creating / Editing Relationships from the Matrix

To create or edit a relationship, double click on a cell to open the trace relationship dialog box. You
can edit or create a new relationship in this dialog. 

Note: The option to "Trace Forward and Backward" will create two separate relationships pointing
both directions.

4.4.4.5 Running Impact Analysis

Contour enables you to see the impact of a change before the change is made by viewing “Impact
Analysis”. Contour displays the project items and team members that may be affected. This is a
benefit of implementing project traceability as it can save time and ensure you understand all the
possible impacts.
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For example, if a business analyst is about to change to a requirement, Contour shows who is
currently working on a related design document, who is working on a related test case and that
someone has already completed the related help page. 

The impact analysis display starts with your current item, then follows forward trace relationships
to display directly impacted items, then other downstream items that may be impacted by the
change.  You can use this window to browse items “on the fly” by clicking on the ID.

You can also click the Filter button to open the filter panel.

Note: The filter panel includes some optional fields that are not displayed by default.  These fields
are Status and Note.

4.4.4.6 Suspect Links

Contour tracks changes as they are made to a project. If items are changed that have forward
relationships to other items, Contour can display a running list of items that may need to be
evaluated for impact. These are considered “suspect links”. 

Click on Project --> Suspect Links to display this window.  This window can be used to navigate
and view individual items by clicking on the item ID's.

Clearing Suspect Links

If you’ve reviewed a suspect link and either made updates or determined there is no impact, click
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the “Clear” link to remove the item as suspect. 

4.4.5 Views

Enter topic text here.

4.4.5.1 Using the Filters View

The Filters tab provides quick access to saved filters.  Filters are grouped by set and public (shared)
filters are marked with an asterisk *.  To apply a filter, just click on the link.  Read about creating
and editing filters.

4.4.5.2 Using the Explorer View

The Explorer view displays project items in a hierarchal structure and allows you to drag and drop
sets and items to arrange.  
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Note: When working with large sets of items – greater than 1,000 per folder, we suggest turning
off the items in the Explorer tree and working with them in the paginated grid (right pane).

To move multiple items, rather than multi-select in the tree, you can multi-select in the grid (right
pane) and drag to their new location.

4.4.5.3 Using the Releases View

The Releases tab displays a tree view of all releases along with "Unassigned" which displays all
items not currently assigned to a release.

The Releases view is designed for reviewing and organizing releases.  To view items assigned to a
release, you can either expand the Release in the tree (good for a small number of items) or click
on the Release and view the items in the grid view.

You can move items from one release to another by dragging and dropping within the tree - or
dragging and dropping from the grid to the tree.  Remember that you can use multi-select in the
grid to move multiple items.

When you move items from one release to another, Contour tracks that change and adds a record
to the version history.

4.4.5.4 Working with the Grid View

Once you start adding data into Contour you’ll use the right pane (grid view) quite often to review,
sort and organize data within Contour.

The grid provides the ability to:

· Click on column header to sort

· Right click on column header to access menu to show and hide columns and sort

· Drag columns to change the order

· Resize columns by dragging the sides of a column

· Single click to select a row, shift + click, CTRL + click to multi-select

TIP: Use SHIFT + Click to deselect multiple items
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· Double click to open an item

· Pagination toolbar at bottom – you can define the number of items to display

You can also drag items from the grid to re-order them in the tree.

4.4.5.5 Viewing Latest Activity (Dashboard)

The dashboard contains the Recent Activities panel which displays newly created, edited or
commented items.  You can click on an item to open the item in a tab.
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4.4.6 Subscribing to Email Notifications

Contour provides a number of ways for teams to stay in sync when things change.  Each item has
a discussion thread (comments) as well as push and pull email notifications.  Users can send out
notifications as well as subscribe to be notified when items are added, edited or commented on
within a project.

Email Notifications can be subscribed at different levels:

1. Individual item

2. Set of items – will send notification for any item within the set

3. Project – will send notifications for all items within a project

To subscribe to email notifications, click on the Actions menu, then Subscribe.  A check box
indicates you are currently receiving updates.

Enabling Notifications

By default, notifications are turned off.  To turn on notifications and select the schedule, click on
“My Profile”, then the notifications tab.  Click on “Edit” and select the scheduled deliver time.

1. Off – no notifications sent

2. Immediate – system checks and sends updates every 5 minutes

3. Daily – notifications are batched up and sent in a single daily email

4. Weekly – notifications are batched up and sent in weekly email
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4.4.7 Importing Requirements & Other Items

You can import data into a project within Contour by selecting the "Project..." button, and then
"Import".  

You have different options for importing data into Contour such as from MS Word, Excel/CSV and
Custom Import.

See the "Microsoft Word Import" for step-by-step instructions.

See the "CSV/Microsoft Excel Import" for step-by-step instructions.

Note: For the custom import option, Jama offers professional services to help you with the
configuration, please contact Jama for more information.

http://www.jamasoftware.com/support.htm
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4.4.7.1 Microsoft Word Import

Preparing the Word Document

To Import a Microsoft Word document, you'll need to save (File, Save as) it in the “Microsoft Word
2003 XML” format.  

Contour imports Microsoft Word documents by evaluating the styles used in a document. The key
to a successfully import process is to use styles consistently in your document.  Contour can use
multiple styles for both requirement names and descriptions.  Additionally if you use the heading
styles within MS Word, Contour will automatically import the document in a hierarchical structure. 

Word import is designed primarily for importing textual requirement name and description fields.
Jama can create a custom import plug in if you have specific needs.  Contact us for more
information. 

Capabilities

· Import item name and description based on paragraph styles in Word such as Heading 1.

· Item names are usually headings.

· Import will recreate tables, list and hyper links and table/list/hyperlinks in table cells.

· Create a version history with version comment for each imported items.

· Keep the hierarchy of the heading structure.

· Sections with sub-sections are treated as folders. Sections without sub-sections are treated
as item.

Limitations

· Import currently doesn’t import table of contents

· Import doesn’t import images, you’ll need to insert these afterwards

· Numbered list will be imported as bulleted list.

· Import don’t support styles on text – fancy formatted text will be converted to plain text

· The heading numbers are not imported.

Step By Step Instructions to Import

1. Login to Contour, select a project or a set within a project

2. Select Actions, Import, Word

3. Select the Set you’d like to import data into - such as requirements

4. Select the MS Word document you’d like to import

5. Enter the style(s) for requirement names

a. you can use a wildcard (*) for example “Headin*”

6. Enter the styles for requirement descriptions.  This is optional – if you don’t enter a style

http://www.jamasoftware.com/contact
http://www.jamasoftware.com/contact
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name here all styles not entered as a requirement name will be imported as requirement
descriptions.

7. Select “Import File”

Contour will create an item that corresponds to each item in the Word document.  For example:

Heading 1 – Requirement 1 Name

Normal – Requirement 1 Description

This would create a single item in Contour with name and description.

4.4.7.2 CSV / Microsoft Excel File Import

A comma separated values or CSV file can be used as a source for data to import into Contour. 

Preparing an Excel Spreadhseet

1. Remove any headers from the file – this is the first row that might contain column headers such
as “Name”, “Description” etc.

2. Make a note of the columns and their position that you’d like to import into Contour.  The left
most column in the spreadsheet is column “1”.

3. Save the worksheet as file type .CSV

Importing into Contour

Prior to importing data, consider creating a new status value of “Imported” and set all items you
are importing to that value.  If the import isn't perfect the first time, this makes it easy to delete all
the items.

1. Login to Contour, select a project or a set within a project

2. Select Project, Import, Excel

3. Select the set you’d like to import data into - such as requirements

4. Select file to import

5. Select the delimiter used - comma is most common

6. Select the text delimiter - double quotes is most common

7. Contour will display each field in the type of artifact you’ve selected

8. For each field, enter the associated column of data in your CSV file.  The first field corresponds
to column 1 in Excel.

9. Enter a default for each field as needed.  For drop down fields, Contour will attempt to match
the record and if not use the selected default.

10.Select “Import File”

Contour will import each row in the file as a new item within Contour.

http://en.wikipedia.org/wiki/Comma-separated_values
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4.5 Reporting & Documents

Contour provides different methods of running reports, exporting data and generating documents.

Standard Reports

Standard Reports are generated from Contour and fill a report template with data from the current
project.

Quick Reports

Quick reports a generated from your current view and can be viewed on-screen or in Microsoft
Word.

Custom Reports

See Custom Reporting

4.5.1 Standard Reports

Contour includes a reporting engine for generating predefined and custom reports from within
Contour. This is a flexible reporting engine that can output data into a variety of formats. 

1. Select a project from the project list and either edit the project or go to requirements

2. Click on the Reports button
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3. Select the report from the list

4. Select any criteria needed to run the report

5. Choose the output format

6. Click on Preview Report

4.5.2 Quick Reports

Quick reports provide a simple way to display a set of data that can be easily printed.  The quick
reports differ from other reports as they are created using a HTML template engine and are
displayed in a popup window.

Two quick reports are provided with the option to include tags and/or trace relationships.  To view
a quick report, from the item or grid select the “Views” menu, then “Quick Reports”.

1. All item fields – displays one or more items with all data fields

2. Name and detail with numbering – this report generates a document style view of the
currently selected set of data.

3. System Requirements Report - a typical system requirements report with name and
description of selected items.  This report is designed to work with all items in a set.  (Click
the set to view all items, then run report)

4.5.3 Custom Report Development

Custom Reporting Overview

Jama Contour provides many built-in reports that are designed to meet most common reporting
requirements.  We’re always adding new reports and are open to suggestions for new reports to
include – if you have suggestions, post your idea to www.jamabackstage.com in the reports
section.

If you have a need that goes beyond built in reports such as adding a logo, new types of reports or
adding custom fields to reports, our custom report solutions are designed to help meet those
needs.

On-Demand Customers

While the overall reporting capabilities are the same, there are a few differences to be aware of if
you are an On-Demand customer.

Reporting Test Data Software and On-Demand Premium customers may export their data and
use this to develop and test reports.  On-Demand customers create test
data manually and duplicate any customizations in the reporting
environment.

Publishing Reports Software and On-Demand Premium customers may upload reports directly
to Contour.  On-Demand customers send reports to Jama for a security
review and upload to their account.
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Jama Support

Contour support covers problems running reports from the Contour web interface but does not
cover designing and troubleshooting reports – such as writing SQL queries or BIRT report designer
specific questions.

Jama does offer fee based support tickets to help with report design.  Each ticket is covers one
problem area, such as troubleshooting BIRT setup, query writing assistance or design questions. 
Contact support to initiate a report design support incident.

Report Design Services

Jama also offers report development which provide you with turn-key custom reports created to
your specifications and delivered via email or posted to your account for On-Demand customers. 
Custom Report services are a cost effective way to quickly deploy custom reports without the
overhead of setting up a report development and testing environments and assigning internal
resources.

Reporting Architecture

Contour ships with an integrated reporting engine called BIRT (Business Intelligence & Reporting
Tools).  BIRT is an open source reporting engine sponsored by Actuate & IBM.   BIRT was selected
for Contour as it was the only solution that renders rich HTML data such as lists, tables and images
that are created by Contour’s rich text editor.

Report templates are XML files created by a report designer that formats data retrieved through
SQL queries and renders the results in formats such as HTML, PDF, Excel, etc.  Once a report
template file is uploaded to Contour, users may generate a report through the web-browser
without needing to know anything about the designer – they just see the report output.

Supported Reporting Tools

For generating reports within Contour, BIRT is the only supported format.  For generating reports
outside the Contour web interface, most any reporting tool may be used.  The reporting tool
connects to the Contour database using a database driver (JDBC).

Note about Rich Text (HTML) – If you do utilize a 3rd party reporting tool, make sure it can report
on HTML text stored within database fields.  If the reporting tool does not offer that functionality,
you can turn off the rich text capability within Contour.

Common 3rd Party Reporting Tools:

· Business Objects

· Crystal Reports

· Actuate

4.5.3.1 Custom Reporting Skills

The reporting engine within Contour provide a flexible and robust platform for designing reports -
from simple lists to complex calculated charts.   You may have individuals within your organization
that can create reports – or you can utilize Jama’s report design services.   

If you are considering designing reports in-house, we’ve compiled the following list of key skills
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needed to create reports:

SQL (Structured Query Language) – The core element of reports are SQL queries that pull data
from the Contour database.  You should have a solid understanding of Selects, Inner & Outer
Joins, and Sub-Selects.

Report / Development IDE’s – BIRT is based on Eclipse so familiarity with IDE’s (Interactive Design
Environments) is very helpful.  You’ll need to install, configure and work with the report designer.

Developer& Tester Mindset – Successful report designers often have solid software engineering
backgrounds and understand the event model and how to troubleshoot.  Reports are a
combination of many moving parts – data sources, queries, parameters and output formats. 
Thinking like a developer and tester helps set the stage for successful design, testing and
deployment of reports.

JavaScript – Fancy report manipulation, calculated fields and other functions use JavaScript within
the report.  A basic understanding of JavaScript functions and syntax will be important, especially
for complex reports.

File Management / Version Control  You’ll want to implement a procedure for tracking and
versioning report design files as you develop, test and deploy reports to Contour. 

4.5.3.2 Setting up a Report Development Environment

It’s a good practice to design and test reports against a non-production instance of Contour.  This
helps reduce the change of impacting your production system if you accidentally run a query that
slows the system for example.   Your Contour license allows for separate instances for this
purpose.

You can use generic test data in your local database or populate it with a copy of your production
database using the XML backup feature.  If you are using custom fields within Contour, you’ll want
to establish a process for periodically syncing your test database with your production database so
you have the same configuration.

Here is an overview of the steps to setup your local environment

a) Create a backup of production data, save it to your computer

b) Install the same type of database you are using in production – or secure access to a test
schema on the database server

c) Install Contour locally

d) Import the production XML database backup file

e) Install and Configure the BIRT report designer

Exporting Production Data (Not Available for OnDemand)

a) Log into your production instance of Contour as “Root” (system administrator account)

b) Select “Tools”, “Backup Database”

c) If you know the size of your database and it’s under 100mb, you can use the “Download”
option, otherwise for larger databases, select a location to save on the server.  Larger
database files can be troublesome to transmit via HTTP.

d) Create the database backup and copy (if needed) to your local computer



Working in Contour 89

© 2009 Jama Software, Inc.

Installing Contour Locally

Follow the “Contour Installation Guide” to install a local copy of Contour on your desktop.   The
setup guide is found on backstage – click here.

Evaluating Contour?  If so, you are likely using the HSQL embedded database that Contour uses by
default.  This works great for quick installs and evaluations, but only allows a single connection to
the database.  We recommend switching to MySQL for best results with report design.

When you begin configuring Contour using the web-based setup pages, follow these instructions:

Database Configuration Page - you’ll want to install the same type of database used by production
for your local design environment, such as MySQL.  As an alternative, you could request a test
schema of Contour be created on your companies database server and connect from your
desktop.

Data Load Page - When prompted to load either default data or backup date, select to load your

XML backup data.

Installing the Report Designer

Download the report designer (BIRT) from Jama’s website.  Please contact your account
representative or support for a link.

Note –It’s important to download the BIRT designer from Jama’s website as other versions may not
be compatible with the current version of Contour.

The report designer requires Java 1.4.2/1.5 JDK/JRE.  If you already installed Contour on your PC,
you already have this installed. If using a different PC you may need to download and install first. 

· Unzip the downloaded file

· To run BIRT, open the directory and run the file BIRT.exe

Configuring the Report Designer

To begin using the designer with Contour, you’ll need to set your resource folder and add a
database driver to access your database.  We’ve created a short video tutorial that we recommend
watching first.

http://www.jamasoftware.com/media/videos/contour_custom_report/contour_custom_report.html

1. Launch the BIRT Designer

2. Select Window, Preferences, expand Report Design and click on Resource

3. Browse to the Contour reports directory and click Okay

4. This is by default {contour install dir}\WEB-Inf\Reports

http://www.jamasoftware.com/media/videos/contour_custom_report/contour_custom_report.html
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Configure Database Driver- Contour supports many different databases so in this step, you
need to configure BIRT to use the specific database driver and connection settings for your
environment.

5. Select File, Open, Change the “Files of Type” to *.rptlibrary

6. Navigate to {contour installation directory}\webapps\contour\WEB-INF\reports

7. Select the file contour_library.rptlibrary, Click Open

8. Within the Outline view (lower left) expand the data sources folder

9. Double click on the “Contour” data source

10. Select “Manage Drivers”

11. Click “Add”

12. Select the directory {Contour install directory}\webapps\contour\WEB-INF\lib and choose
the driver file specified in the tables below…

For example, if Contour is installed on Windows using the default settings the file is: 
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C:\Program Files\Contour\server\webapps\contour\WEB-INF\lib\mysql-connector-java-
3.1.12-bin.jar

13. Click open to select the file and add to the drivers list within BIRT

14. Select the driver class per the tables below

15. In the database URL, confirm the URL is correct per examples below

16. Update your database user name

17. Update your database password 

18. Click on “Test Connection” and confirm success

19. Click “Finish”

Database Driver Properties Reference

MySQL Database

Driver File mysql-connector-java-3.1.12-bin.jar

Where to obtain driver Contour install directory

Driver Class com.mysql.jdbc.Driver (v3.1)

Database URL jdbc:mysql://localhost/contour?
useUnicode=true&characterEncoding=UTF8

Microsoft SQL Server 

Driver File jtds-1.2.jar

Where to obtain driver Contour install directory

Driver Class net.sourceforge.jtds.jdbc.Driver (v1.2)

Database URL jdbc:mysql://localhost/contour?
useUnicode=true&characterEncoding=UTF8

HSQL Server 

Driver File hsqldb.jar

Where to obtain driver Contour install directory

Driver Class org.hsqldb.jdbcDriver (v1.8)
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Database URL jdbc:hsqldb:file:C:\contour\database\contour

Note - the HSQL database is located in your Contour home directory.
This location was entered when completing the initial installation of
Contour from the web-page. 

Default Username SA

Default Password empty

Congratulations, you now have established a reusable connection to the Contour database for
updating and designing new custom reports. 

4.5.3.3 Update Reporting Data from Production

The process for setting up “test” data to develop reports against differs between OnDemand on
Software installations.  

Contour Software Installations
From time to time you’ll want to refresh your local database with the production database.  The
XML backup will provide you with both the current database schema as well as data to test your
reports with.

We will assume you are using MySQL as the database, if using another replace the MySQL specific
commands with those for your selected database or work with your database administrator.

a) Stop your local Contour server (Windows Services, Apache Monitor etc.)

b) Open MySQL Command Line Client / Windows Start Menu, MySQL, MySQL 5.1, MySQL
Command Line Client

c) Enter the password for “Root” – i.e. “password”

d) At the mysql> prompt enter:  drop database contour;

e) You should see “Query OK”, then enter:  create database contour character set utf8;

f) Close MySQL command window

g) Start your local Contour server, wait a few seconds and open your browser to your local
Contour, you should see the following window.
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a) Select your saved backup XML file and click the “Load Backup Data” button

b) Contour will import the production database and display the login screen.

Remember that any local changes you’ve made such as to security or artifact types on your test
system will be replaced by the production data configuration.

Contour OnDemand Subscriptions

For Contour OnDemand subscriptions, set up a local instance of Contour, load the default
database, and then create a small set of data to test reports against. 

If fields are added to customize Contour, you’ll need to add those same fields to the report
instance.  We provide a report that lists the item types and underlying fields to help simplify this
process.  To load the report (if not already visible) from within Contour, add a new report and
browse to your Contour installation folder, then to /WEB-INF/reports/artifactTypes.rptdesign.  The
report does not need any parameters.

NOTE: A feature to enable administrators to download a snapshot of data from OnDemand on a
“self service” basis is on our roadmap.  

4.5.3.4 Creating Your First Report

We’ve created a short video tutorial which provides a visual step by step overview of creating
custom reports:

http://www.jamasoftware.com/media/videos/contour_custom_report/contour_custom_report.html

http://www.jamasoftware.com/media/videos/contour_custom_report/contour_custom_report.html


Contour 2.5 User Guide94

© 2009 Jama Software, Inc.

4.5.3.5 Report Libraries

Jama provides a reporting library with Contour that includes a reusable connection to the Contour

database. In order to use this library, once you have updated the database connection

information, you can start using the library in your reports. 

You can also create new libraries for your organization with database connection information and

other reusable components that makes it quick to create reports. 

4.5.3.6 Report Parameters

Report parameters allow report designers to incorporate criteria set by users within Contour such
as date or set of items.  We’ve created a video tutorial on configuring and passing parameters to
reports here.

You can define any number of parameters and use these to run reports within the BIRT designer. 
For reports uploaded to Contour, you are limited to the following built in parameters.  Please
contact us to request additional parameters if needed.

The preconfigured parameters are all available within the Contour_2 report library and can be
added to a report by dragging them from the library to the parameters section of your report
outline.

Preconfigured Parameters

Parameter Description

report_organizationId Passed by default to all reports, this is the ID for the current
organization

report_projectId ID for current project

report_artifactGroupId Artifact group such as “Requirements”

report_releaseId Release

report_priorityId Priority

report_statusId Status

report_string1 User defined string

report_string2 User defined string

report_string3 User defined string



Working in Contour 95

© 2009 Jama Software, Inc.

report_date1 User defined date format:  mm/dd/yyyy

report_date2 User defined date format:  mm/dd/yyyy

4.5.3.7 External Resources

Eclipse BIRT Resources

The Eclipse BIRT product has a large community of developers and users with lots of information
available on the web.  The BIRT product home page is: http://www.eclipse.org/birt/phoenix/

Reporting
Bugs

We’ve found that BIRT is an active project with heavy involvement from IBM and
Actuate so bugs (that are clearly defined and reported) are resolved quickly.  To report
a bug, sign up for an account and post to: https://bugs.eclipse.org/bugs/enter_bug.
cgi?product=BIRT

Communitie
s

Two primary developers behind BIRT blog at http://birtworld.blogspot.com/.  

Birt Exchange has a user forum as well as a BIRT newsgroup mirror: http://www.birt-
exchange.com/

SQL
Reference

http://www.w3schools.com/sql/default.asp

 

http://www.eclipse.org/birt/phoenix/
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